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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

Product Name HP Compaq 6730s Notebook PC  √ √ √

 HP Compaq 6735s Notebook PC √    

Processors Intel® Core™2 Duo processors

 ● P8600 2.40-GHz processor, 3-
MB L2 cache, 1066-MHz front
side bus (FSB)

  √ √

 ● P8400 2.26-GHz processor, 3-
MB L2 cache, 1066-MHz FSB

  √ √

 ● T9400 2.53-GHz processor, 6-
MB L2 cache, 1066-MHz FSB

  √ √

 ● T5670 1.80-GHz processor, 2-
MB L2 cache, 800-MHz FSB

  √ √

 ● T5870 2.0-GHz processor, 2-MB
L2 cache, 800-MHz FSB

  √ √

 ● T7500 2.20-GHz processor, 4-
MB L2 cache, 800-MHz FSB

  √ √

 ● P7370 2.0-GHz processor, 3-MB
L2 cache, 1066-MHz FSB

  √ √

 Intel Celeron® M processors   

 ● 575 2.0-GHz processor, 1-MB L2
cache, 667-MHz FSB

 √   

 ● 585 2.16-GHz processor, 1-MB
L2 cache,667-MHz FSB

 √   

 Intel Celeron Dual-Core processors

 ● T1600 1.66–GHz processor, 1-
MB L2 cache, 667-MHz FSB

 √  √

 ● T1700 1.83-GHz processor, 1-
MB L2 cache, 667-MHz FSB

 √  √

 AMD Turion™ Ultra Dual-Core processors   
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

 ● ZM-80 2.1-GHz processor, 2-MB
L2 cache, 35W

√    

 ● ZM-82 2.2-GHz processor, 2-MB
L2 cache, 35W

√    

 ● ZM-84 2.3-GHz processor, 2-MB
L2 cache, 35W

√    

 ● ZM-86 2.4-GHz processor, 2-MB
L2 cache, 35W

√    

 AMD Turion Dual-Core processors:

 ● RM-70 2.0-GHz processor, 1-MB
L2 cache, 35W

√    

 ● RM-72 2.1-GHz processor, 1-MB
L2 cache 35W

√    

 AMD Athlon™ Dual-Core processors:

 ● QL-60 1.9-GHz processor, 1-MB
L2 cache 35W

√    

 ● QL-62 2.0-GHz processor, 1-MB
L2 cache 35W

√    

 AMD Sempron™ processor:

 ● SI-40 2.0-GHz processor, 512-
KB L2 cache, 25W

√    

Chipsets Northbridge: Intel GL40 with up to 667-
MHz FSB

   √

 Northbridge: Intel GL40 with up to 667-
MHz FSB

 √   

 Northbridge: Intel GM45 with up to
1066-MHz FSB

  √  

 Northbridge: Intel PM45 with up to
1066-MHz FSB

   √

 Southbridge: Intel ICH9M  √ √ √

 AMD RS780MN √    

 Southbridge: AMD SB700 √    

Graphics ATI-M82se with Hypermemory
support, discrete graphics subsystem
memory

   √

 Intel Universal Memory Architecture
(UMA) graphics subsystem integrated
with shared video memory
(dynamically allocated)

 √ √  
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

 AMD RS780MN Integrated Universal
Memory Architecture (UMA) graphics
subsystem with shared video memory
(dynamically allocated)

√    

Panels All display assemblies include 2
wireless local area network (WLAN)
antennae

√ √ √ √

 ● 15.4-inch WXGA √ √ √ √

 ● 15.4-inch WXGA BrightView √ √ √ √

 ● 15.4-inch WXGA with webcam √ √ √ √

 ● 15.4-inch WXGA BrightView with
webcam

√ √ √ √

Memory 2 customer-accessible/upgradable
memory module slots

√ √ √ √

 Supports dual-channel memory √ √ √ √

 Supports up to 4 GB of system RAM √ √ √ √

 PC2-5300, 667-MHz, DDR2 √ √ √ √

 PC2-5300, 800-MHz, DDR2 √ √ √ √

 Supports the following configurations
in all countries and regions except
Brazil:

● 8192-MB total system memory
(4096 x 2, dual-channel)

● 4096-MB total system memory
(4096 x 1, dual-channel)

● 4096-MB total system memory
(2048 × 2, dual-channel)

● 3072-MB total system memory
(2048 + 1024)

● 2048-MB total system memory
(1024 × 2, dual-channel)

● 2048-MB total system memory
(2048 × 1)

● 1024-MB total system memory
(1024 × 1)

√ √ √ √
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

 Supports the following configurations
only in Brazil:

● 3072-MB total system memory
(2048 x 1024, dual-channel)

● 2048-MB total system memory
(2048 × 1)

● 2048-MB total system memory
(1024 × 2, dual-channel)

● 1024-MB total system memory
(1024 × 1)

√ √ √ √

Hard drives Supports 9.5-mm, 2.5-inch hard drives √ √ √ √

 Customer-accessible √ √ √ √

 Serial ATA √ √ √ √

 Supports the following drives:

● 320-GB, 5400-rpm

● 250-GB, 5400-rpm

● 160-GB, 7200-rpm

● 160-GB, 5400-rpm

● 120-GB, 5400-rpm

√ √ √ √

 ● 120-GB, 7200-rpm    √

 HP 3D DriveGuard √ √ √ √

Optical drives Fixed (removal of 1 screw required) √ √ √ √

 Customer-accessible √ √ √ √

 Serial ATA √ √ √ √

 12.7-mm tray load √ √ √ √

 Supports the following drives:

● DVD-ROM Drive

● DVD/CD-RW Combo Drive

● DVD±RW Double-Layer Drive
with LightScribe

● DVD±RW SuperMulti Double-
Layer Drive with LightScribe

√ √ √ √

 ● Blu-ray Disc ROM Drive with
SuperMulti DVD±R/RW Double-
Layer

   √
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

Diskette drive Supports external USB diskette drive
only

√ √ √ √

 Supports boot from external USB
diskette drive

√ √ √ √

 Supports 3-mode diskette drive √ √ √ √

Audio HD audio - ADI1984 √ √ √ √

Modem 56K V.92 3.8 cm (1.5-inch) data/fax
modem with digital line guard

√ √ √ √

Ethernet 10/100 Ethernet network interface
card (NIC)

√ √ √  

 10/100/1000 Ethernet network
interface card (NIC)

   √

 S3/S4/S5 wake on LAN: DC - no √ √ √ √

 S3/S4/S5 wake on LAN: AC - yes √ √ √ √

Wireless Integrated WLAN options by way of wireless module:

 2 WLAN antennae built into display
assembly

√ √ √ √

 Support for no-WLAN option √ √ √ √

 Support for the following WLAN
formats:

● Broadcom 802.11a/b/g/n

● Broadcom 802.11b/g

√ √ √ √

 ● Intel 802.11 a/b/g

● Intel 802.11 a/b/g/n

 √ √ √

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option √ √ √ √

 Broadcom Bluetooth 2.0+EDR √ √ √ √

External
media cards

One ExpressCard/54 slot √ √ √ √

 Media Card Reader supporting
Memory Stick (MS), Memory Stick Pro
(MSP), Secure Digital (SD) Memory
Card, Secure Digital High Capacity
(SDHC) Memory Card,
MultiMediaCard (MMC), and xD-
Picture Card formats.

√ √ √ √

Ports Audio-in (stereo microphone) √ √ √ √

 Audio-out (stereo headphone) √ √ √ √
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

 RJ-11 (modem) √ √ √ √

 RJ-45 (Ethernet, includes link and
activity lights)

√ √ √ √

 USB (4) √ √ √ √

 VGA (Dsub 15-pin) supporting 1600 ×
1200 external resolution at 75-GHz
(hot plug/unplug with auto-detect)

√ √ √ √

 3-pin AC power √ √ √ √

Keyboard/
pointing
devices

11.97-inch keyboard with embedded
numeric keypad

√ √ √ √

 TouchPad only, with 2 TouchPad
buttons and vertical scrolling (taps
enabled as default)

√ √ √ √

Power
requirements

90-W AC adapter with localized cable
plug support (2-wire plug with ground
pin, supports 2-pin DC connector)

   √

 65-W AC adapter with localized cable
plug support (2-wire plug with ground
pin, supports 2-pin DC connector)

√ √ √  

 8-cell, 63-Wh Li-ion battery √ √ √ √

 6-cell, 47-Wh Li-ion battery √ √ √ √

Security Supports Kensington security sock √ √ √ √

Operating
system

Preinstalled:     

 Windows Vista® Basic 32 with Office
Ready

√ √ √ √

 Windows Vista Basic 32 (for Japan
and the United Kingdom only)

√ √ √ √

 Windows Vista Basic 32 with Office
Personal with PowerPoint (Japan
only)

√ √ √ √

 Windows Vista Basic 32 Japan with
Office Personal (Japan only)

√ √ √ √

 Windows Vista Basic 32 with Office
Professional (Japan only)

√ √ √ √

 Windows Vista Business 32 √ √ √ √

 Windows Vista Business 32 with
Office Ready

√ √ √ √

 Windows Vista Business 32 with
Office Personal (Japan only)

√ √ √ √
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

 Windows Vista Business 32 with
Office Personal with PowerPoint
(Japan only)

√ √ √ √

 Windows Vista Business 32 with
Office Professional (Japan only)

√ √ √ √

 Windows Vista Home Premium with
Office Ready

√ √ √ √

 Windows® XP Professional (Japan
and the United Kingdom only)

√ √ √ √

 Windows XP Professional with Office
Professional (Japan only)

√ √ √ √

 Windows XP Professional with Office
Ready

√ √ √ √

 Windows XP Professional with Office
Personal (Japan only)

√ √ √ √

 Windows XP Professional with Office
Personal with PowerPoint (Japan
only)

√ √ √ √

 FreeDOS √ √ √ √

 Red Flag Linux (in the People's
Republic of China only)

√ √ √ √

 Restore media:     

 Windows Vista Home Basic 32 √ √ √ √

 Windows Vista Home Premium √ √ √ √

 Windows Vista Business 32 √ √ √ √

 Windows Vista Business 64 √ √ √ √

 Windows XP Professional √ √ √ √

 Red Flag Linux (in the People's
Republic of China only)

√ √ √ √

 DRDVD Windows Vista √ √ √ √

 DRDVD Windows XP Pro √ √ √ √

 Windows Vista Office Ready DVD √ √ √ √

 Certified: Microsoft® WHQL √ √ √ √

 Web Support: Windows XP Pro √ √ √ √

Serviceability End-user replaceable parts:     

 AC adapter √ √ √ √

 Battery (system) √ √ √ √
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Category Description Computer
models
equipped
with M780G
system board

Computer
models
equipped with
GL40 system
board

Computer
models
equipped
with GM45
system board

Computer
models
equipped
with PM45
system board

 Hard drive √ √ √ √

 Memory module √ √ √ √

 Optical drive √ √ √ √

 WLAN module √ √ √ √
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2 External component identification

Top components
Display components

Item Component Function

(1) WLAN antenna locations Send and receive signals from one or more WLAN devices.
These antennae are not visible from the outside of the
computer.

(2) Webcam light (select models only) On: The integrated camera is in use.

(3) Webcam (select models only) Records audio and video and captures still photographs.
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TouchPad

Item Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the
screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Buttons, switch, lights, and speakers

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a wireless
local area network (WLAN) device, the HP Broadband
Wireless Module, and/or a Bluetooth device, is on.

● Off: All wireless devices are off.

(2) Wireless button Turns the wireless feature on or off, but does not establish
a wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

● Off: The computer is off or in Hibernation.
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Item Component Function

(4) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to initiate
Hibernation.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(5) Speakers (2) Produce sound.

(6) Caps lock light On: Caps lock is on.

(7) Internal display switch Turns off the display if the display is closed while the power
is on.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.
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Item Component Function

(2) Function keys Execute frequently used system functions when pressed
in combination with the fn key.

(3) num lk key When pressed in combination with the fn key, the num lk
key enables and disables the embedded numeric keypad.

(4) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(5) Windows applications key Displays a shortcut menu for items beneath the pointer.

(6) Windows logo key Displays the Windows Start menu.

(7) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.
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Front components

Item Component Function

(1) Media Card Reader Supports the Memory Stick (MS), Memory Stick Pro (MSP),
Secure Digital (SD) Memory Card, Secure Digital High
Capacity (SDHC) Memory Card, MultiMediaCard (MMC),
and xD-Picture Card formats.

(2) Drive light ● Blinking turquoise. The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

(3) Audio-out (headphone) jack Connects optional powered stereo speakers, headphones,
ear buds, a headset, or television audio.

(4) Internal microphone Records sound.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

Right-side components

Item Component Function

(1) USB ports (2) Connect optional USB devices.

(2) Optical drive Reads optical discs and, on select models, also writes to
optical discs.

(3) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left-side components

Item Component Function

(1) RJ-11 (modem) jack Connects a modem cable.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) External monitor port Connects an external VGA monitor or projector.

(4) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(5) Power connector Connects an AC adapter.

(6) RJ-45 (network) jack Connects a network cable.

(7) USB ports (2) Connect optional USB devices.

(8) ExpressCard slot Supports optional ExpressCards.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) Memory module compartment Contains a memory module.

(5) Hard drive bay Holds the hard drive.

(6) WLAN module compartment (select models only) Contains a WLAN module slot.

CAUTION: To prevent an unresponsive system, use only
a wireless module authorized for use in the computer by
the governmental agency that regulates wireless devices
in your country or region. If you install the module and then
receive a warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.
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3 Illustrated parts catalog

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for your
computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components

Item Description Spare part number

(1) Display assembly (includes 2 WLAN antenna transceivers and cables)

 For use only with HP Compaq 6735s Notebook PC models  

 15.4-inch WXGA BrightView display assembly (for use in all countries and regions except
Brazil)

491587-001
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Item Description Spare part number

 15.4-inch WXGA display assembly (for use only in all countries and regions except Brazil) 491584-001

 15.4–inch WXGA display assembly (for use only in Brazil) 491585-001

 15.4-inch WXGA display assembly with webcam (for use only in Brazil) 491586-001

 15.4-inch WXGA BrightView display assembly (for use only in Brazil) 491588-001

 15.4-inch WXGA BrightView display assembly with webcam (for use only in Brazil) 491589-001

 For use only with HP Compaq 6730s Notebook PC models  

 15.4-inch WXGA display assembly (for use in all countries and regions except Brazil) 491261-001

 15.4-inch WXGA BrightView display assembly (for use in all countries and regions except
Brazil)

491262-001

 15.4-inch WXGA display assembly with webcam (for use in all countries and regions except
Brazil)

491263-001

 15.4-inch WXGA BrightView display assembly with webcam (for use in all countries and
regions except Brazil)

491264-001

 Display assembly internal components (not illustrated):

 For use only with HP Compaq 6735s Notebook PC models  

 Display bezel and cover for use only with computers not equipped with a webcam 494108-001

 Display bezel and cover for use only with computers equipped with a webcam 494109-001

 Webcam with module board 494110-001

 For use only with HP Compaq 6730s Notebook PC models  

 Display bezel and cover for use only with computer models not equipped with a webcam 491257-001

 Display bezel and cover for use only with computer models equipped with a webcam 491258-001

 Webcam with module board 491251-001

 Display Cable Kit (not illustrated)  

 For use with HP Compaq 6730s Notebook PC models (includes wireless antenna and webcam
cables)

491259-001

 For use with HP Compaq 6735s Notebook PC models (includes wireless antenna and webcam
cables)

494114-001

 Display hinges  

 For use with HP Compaq 6735s Notebook PC models (includes left and right hinges) 491610-001

 For use with HP Compaq 6730s Notebook PC models (includes left and right hinges) 496680-001

 Display inverter  

 For use only with HP Compaq 6730s Notebook PC models 491256-001

 For use only with HP Compaq 6735s Notebook PC models 494116–001

(2) Switch cover (includes LED power board and cable)  

 For use only with HP Compaq 6730s Notebook PC models 491288-001

 For use only with HP Compaq 6735s Notebook PC models 494115-001
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(3) LED power button board  (included in the switch cover)  

(4) Keyboard

 For use only with HP Compaq 6730s Notebook PC models  

 For use in Brazil 491274-201

 For International use 491274-B31

 For use in the Czech Republic 491274-221

 For use in Denmark 491274-081

 For use in France 491274-051

 For use in French Canada 491274-121

 For use in Finland 491274-B71

 For use in Germany 491274-041

 For use in Greece 491274-DJ1

 For use in Hungary 491274-211

 For use in Iceland 491274-DD1

 For use in Israel 491274-BB1

 For use in Italy 491274-061

 For use in Japan 491274-291

 For use in Latin America 491274-161

 For use in Norway 491274-091

 For use in Portugal 491274-131

 For use in Russia 491274-251

 For use in Saudi Arabia 491274-171

 For use in Slovakia 491274-231

 For use in Slovenia 491274-BA1

 For use in South Korea 491274-AD1

 For use in Spain 491274-071

 For use in Switzerland 491274-BG1

 For use in Thailand 491274-281

 For use in Turkey 491274-141

 For use in Taiwan 491274-AB1

 For use in the United Kingdom 491274-031

 For use in the United States 491274-001

 For use only with HP Compaq 6735s Notebook PC models  

 For use in Belgium 491603-A41
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 For use in Brazil 491603-201

 For use in the Czech Republic 491603-221

 For use in Denmark 491603-081

 For use in Finland 491603-B71

 For use in France 491603-051

 For use in French Canada 491603-121

 For use in Germany 491603-041

 For use in Greece 491603-151

 For use in Hungary 491603-211

 For use in Iceland 491603-DD1

 For use in Israel 491603-BB1

 For use in Italy 491603-061

 For International use 491603-B31

 For use in Japan 491603-291

 For use in Latin America 491603-161

 For use in Norway 491274-091

 For use in Portugal 491603-131

 For use in Russia 491603-251

 For use in Saudi Arabia 491603-171

 For use in Slovakia 491603-231

 For use in Slovenia 491603-BA1

 For use in South Korea 491603-AD1

 For use in Spain 491603-071

 For use in Switzerland 491603-BG1

 For use in Thailand 491603-281

 For use in Taiwan 491603-AB1

 For use in Turkey 491603-141

 For use in the United Kingdom 491603-031

 For use in the United States 491603-001

(5) Speakers  

 For use only with HP Compaq 6730s Notebook PC models 491277-001

 For use only with HP Compaq 6735s Notebook PC models 491612-001

(6) Top cover (includes TouchPad board and cable, and TouchPad button board and cable) 491254-001
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(7) RJ-11 connector (included in cable kit. For HP Compaq 6730s Notebook PC models, see
cable kit spare part number 491287-001. For HP Compaq 6735s Notebook PC models, see
cable kit spare part number 491608-001.) See Cable Kit on page 29 for more Cable Kit spare
part number information.

 

(8) TouchPad (included with top cover, spare part number 491254-001)  

Plastics Kit (see Plastics Kit on page 28 for more Plastics Kit spare part information):  

 For use only with HP Compaq 6730s Notebook PC models 491253-001

 For use only with HP Compaq 6735s Notebook PC models 491616-001

(9a) ExpressCard slot bezel 

(9b) WLAN module compartment cover

(9c) Hard drive bay cover

(9d) Memory module compartment cover

 TouchPad components

(10) TouchPad cable (included with top cover, spare part number 491254-001)  

(11) TouchPad bracket (included with top cover, spare part number 491254-001, which also
includes the TouchPad button board actuators, which are not illustrated)

 

(12) TouchPad board and cable (included with top cover, spare part number 491254-001)  

(13) Heat sink for use only with HP Compaq 6730s Notebook PC models with discrete graphics
subsystem memory

491255-001

 Thermal modules  

 For use only with HP Compaq 6730s Notebook PC models 491979-001

 For use only with HP Compaq 6730s Notebook PC models equipped with Intel processors with
UMA graphics subsystem memory

496679-001

 For use only with HP Compaq 6735s Notebook PC models 491613-001

(14) Fan  

 For use only with HP Compaq 6730s Notebook PC models 490324-001

 For use only with HP Compaq 6735s Notebook PC models 491621-001

(15) Broadcom Bluetooth modules

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
Bluetooth module cables are included in the Cable Kit. For HP Compaq 6730s Notebook PC
models, see cable kit spare part number 491287-001. For HP Compaq 6735s Notebook PC
models, see cable kit spare part number 491608-001. See Cable Kit on page 29 for more
Cable Kit spare part number information.

 

 For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

 For use in Japan and Asia Pacific countries and regions 450066-001

(16) USB connector

NOTE: The USB connector does not include a USB cable. The USB cables are included in
the Cable Kits. For HP Compaq 6730s Notebook PC models, see cable kit spare part number
491287-001. For HP Compaq 6735s Notebook PC models, see cable kit spare part number
491608-001. See Cable Kit on page 29 for more Cable Kit spare part number information.
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(17) System board (includes replacement thermal material and the ExpressCard assembly)

 For use only with HP Compaq 6730s Notebook PC models  

 For use only with computer models equipped with Intel processors with discrete graphics
subsystem memory (includes 256-MB of graphics subsystem memory)

491976-001

 For use only with computer models equipped with GL40 system boards with Intel processors
with UMA graphics subsystem memory

491250-001

 For use only with computer models equipped with GL45 system boards with Intel processors
with UMA graphics subsystem memory

501354-001

 For use only with HP Compaq 6735s Notebook PC models  

 For use only with computer models equipped with UMA graphics subsystem memory 494106-001

 Processor (includes replacement thermal material) (not illustrated) 

 Intel Core2 Duo processors (for use only with HP Compaq 6730s Notebook PC models)

 ● P8600 2.40-GHz (3-MB L2 cache, 1066-MHz FSB) 491285-001

 ● P8400 2.26-GHz (3-MB L2 cache, 1066-MHz FSB) 491284-001

 ● T9400 2.53-GHz (6-MB L2 cache, 1066-MHz FSB) 491286-001

 ● T5670 1.80-GHz (2-MB L2 cache, 800-MHz FSB) (socketed) (not available for Japan) 496677-001

 ● T5870 2.0-GHz (2-MB L2 cache, 800-MHz FSB) (socketed) (not available for Japan) 496678-001

 ● P7370 2.0-GHz (3-MB L2 cache, 1066-MHz FSB) (Only available with Intel WLAN) 506451-001

 Intel Celeron M processors (for use only with HP Compaq 6730s Notebook PC models) 

 ● 575 2.0-GHz (1-MB L2 cache, 667-MHz FSB) 491282-001

 ● 585 2.16-GHz (1-MB L2 cache, 667-MHz FSB) 491283-001

 Intel Celeron Dual-Core processors (for use only with HP Compaq 6730s Notebook PC models)

 ● T1600 1.66-GHz (1-MB L2 cache, 667-MHz FSB) 506449-001

 ● T1700 1.83-GHz (1-MB L2 cache, 667-MHz FSB) 506450-001

 AMD Turion Ultra Dual-Core processors (for use only with HP Compaq 6735s Notebook PC models)

 ● ZM-80 2.1-GHz (2-MB L2 cache, 35W) 491581-001

 ● ZM-82 2.2-GHz (2-MB L2 cache, 35W) 491582-001

 ● ZM-84 2.3-GHz (2-MB L2 cache, 35W) 506280-001

 ● ZM-86 2.4-GHz (2-MB L2 cache, 35W) 491583-001

 AMD Turion Dual-Core processors (for use only with HP Compaq 6735s Notebook PC models)

 ● RM-70 2.0-GHz (1-MB, L2 cache, 35W) 491580-001

 ● RM-72 2.1-GHz (1-MB, L2 cache, 35W) 506279-001

 AMD Athlon Dual-Core processors (for use only with HP Compaq 6735s Notebook PC
models)

 

 ● QL-60 1.9-GHz (1-MB, L2 cache, 35W) 491579-001

 ● QL-62 2.0-GHz (1-MB, L2 cache, 35W) 506278-001
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 AMD Sempron processor (for use only with HP Compaq 6735s Notebook PC models) 

 ● SI-40 2.0-GHz (512-KB, L2 cache, 25W) 491578-001

(18) RTC battery 449137-001

(19) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part numbers 491287-001 (for HP
Compaq 6730s Notebook PC models) and 491608-001 (for HP Compaq 6735s Notebook PC
models). See Cable Kit on page 29 for more Cable Kit spare part information.

 

 For use in all countries and regions except Australia and New Zealand 461749-001

 For use only in Australia and New Zealand 461749-011

 Thermal Material Kits (not illustrated)

 For use in all countries and regions except Japan and Asia Pacific countries and regions 413706-001

 For use only in Japan and Asia Pacific countries and regions 445853-001

(20) Optical drive connector 491269-001

(21) Base enclosure  (includes rubber feet)  

 For use only with HP Compaq 6730s Notebook PC models 491252-001

 For use only with HP Compaq 6735s Notebook PC models 491604-001

(22) Battery  

 8-cell, 63-Wh Li-ion battery  

 For use only with HP Compaq 6730s Notebook PC models 491279-001

 For use only with HP Compaq 6735s Notebook PC models 496897-001

 6-cell, 47-Wh Li-on battery  

 For use only with HP Compaq 6730s Notebook PC models 491278-001

 For use only with HP Compaq 6735s Notebook PC models 501870-001

(23) WLAN module  

 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module  (for use in all countries and regions
except Pakistan, Russia, and the Ukraine)

480985-001

 Broadcom 4312 802.11b/g WLAN modules

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

459263-001
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 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

459263-002

 Broadcom 4322 802.11a/b/g/n WLAN modules:

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

487330-002

 Broadcom 802.11a/b/g WLAN modules:  

 For use only on HP Compaq 6735s Notebook PC models:  

Computer major components 25



Item Description Spare part number

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

441075-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Cayman Islands, the Central African Republic,
Chad, Chile, the People's Republic of China, Columbia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St.
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-002

 ● For use in Japan 441075-291

(24) Hard drive (includes hard drive bracket)

 For use only with HP Compaq 6730s Notebook PC models

 320-GB, 5400-rpm 510176-001

 250-GB, 5400-rpm 491268-001

 160-GB, 7200-rpm 506452–001

 160-GB, 5400-rpm 491267-001

 120-GB, 7200-rpm 491266-001

 120-GB, 5400-rpm 491265-001

 For use only with HP Compaq 6735s Notebook PC models  

 250-GB, 5400-rpm 491598-001

 160-GB, 5400-rpm 491597-001

 120-GB, 5400-rpm 491596-001

(25) Memory module  

 PC2-5300, 667-MHz, DDR2 (for use only with HP Compaq 6730s Notebook PC models)  

 1-GB 491476-001

 2-GB 491478-001

 PC2-6400, 800-MHz, DDR2 (for use only with HP Compaq 6730s Notebook PC models)  
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 1-GB 491477-001

 2-GB 491479-001

 PC2-5300, 667-MHz, DDR2 (for use only with HP Compaq 6735s Notebook PC models)  

 1024-MB 491591-001

 2048-MB 491592-001

 PC2-6400, 800-MHz, DDR2 (for use only with HP Compaq 6735s Notebook PC models)  

 1024-MB 491594-001

 2048-MB 491595-001

(26) Optical drive (includes bezel and bracket)

 For use only with HP Compaq 6730s Notebook PC models  

 DVD-ROM Drive 491270-001

 DVD/CD-RW Combo Drive 491271-001

 DVD±RW Double-Layer Drive with LightScribe 491272-001

 Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer 491273-001

 For use only with HP Compaq 6735s Notebook PC models  

 DVD-ROM Drive 491599-001

 DVD/CD-RW Combo Drive 491600-001

 DVD±RW SuperMulti Double-Layer Drive with LightScribe 491601-001

 Rubber Kit (not illustrated, contains 7 computer feet and 8 display bezel screw covers)  

 For use only with HP Compaq 6730s Notebook PC models 491275-001

 For use only with HP Compaq 6735s Notebook PC models 491620-001
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Item Description Spare part number

 Plastics Kit:

 For use only with HP Compaq 6730s Notebook PC models 491253-001

 For use only with HP Compaq 6735s Notebook PC models 491616-001

(1) ExpressCard slot bezel  

(2) WLAN module compartment cover (includes one captive screw, secured by a C-clip)

(3) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(4) Hard drive bay cover (includes 2 captive screws, secured by C-clips)
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Cable Kit

Item Description Spare part number

 Cable Kit:  

 For use only with HP Compaq 6730s Notebook PC models 491287-001

 For use only with HP Compaq 6735s Notebook PC models 491608-001

(1) RJ-11 jack cable

(2) USB cable

(3) Bluetooth module cable 
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Item Description Spare part number

(1) Optical drive (includes bezel and bracket)

 For use only with HP Compaq 6730s Notebook PC models  

 DVD±RW Double-Layer Drive with LightScribe 491272-001

 DVD-ROM Drive 491270-001

 DVD/CD-RW Combo Drive 491271-001

 Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer 491273-001

 For use only with HP Compaq 6735s Notebook PC models  

 DVD-ROM Drive 491599-001

 DVD/CD-RW Combo Drive 491600–001

 DVD±RW SuperMulti Double-Layer Drive with LightScribe 491601-001

(2) Hard drive (includes bracket)

 For use only with HP Compaq 6730s Notebook PC models  

 320-GB, 5400-rpm 510176-001

 250-GB, 5400-rpm 491268–001

 160-GB, 7200-rpm 506452-001

 160-GB, 5400-rpm 491267-001

 120-GB, 7200-rpm 491266-001

 120-GB, 5400-rpm 491265-001

 For use only with HP Compaq 6735s Notebook PC models  

 250-GB, 5400-rpm 491598-001
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 160-GB, 5400-rpm 491597-001

 120-GB, 5400-rpm 491596-001
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Miscellaneous parts
Description Spare part number

AC adapters

65-W AC adapter 463958-001

90-W Slimline AC adapter (for use only with HP Compaq 6730s Notebook PC models in all countries
and regions except India)

463955-001

90-W Slimline AC adapter (for use only with HP Compaq 6730s Notebook PC models in India) 463956-001

Logo Kit  

For use only with HP Compaq 6730s Notebook PC models 491281-001

For use only with HP Compaq 6735s Notebook PC models 491622-001

Display Cable Kit  (For use only with HP Compaq 6735s Notebook PC models) 494114-001

Display miscellaneous (includes a 15-inch display miscellaneous assembly, aluminum foil shield,
and tape) for use only with HP Compaq 6735s Notebook PC models

500328-001

Power cord:

For use in the United States 490371-001

For use in Australia and New Zealand 490371-011

For use in Europe, the Middle East, and Africa 490371-021

For use in the United Kingdom and Singapore 490371-031

For use in Italy 490371-061

For use in Denmark 490371-081

For use in Switzerland 490371-111

For use in Brazil 490371-201

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in Taiwan 490371-AB1

For use in South Korea 490371-AD1

For use in South Africa 490371-AR1

For use in Israel 490371-BB1

For use in Argentina 490371-D01

For use in India 490371-D61

Screw Kit  

For use only with HP Compaq 6730s Notebook PC models 491276-001
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For use only with HP Compaq 6735s Notebook PC models 491617-001

Screw Kit contents:

● Phillips PM3.0×4.0 screw

● Phillips PM2.0x3.0 screw

● Phillips PM2.5×6.0 captive screw

● Phillips PM2.5×10.0 captive screw

● Phillips PM2.5×9.0

● Phillips PM2.5×4.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.0×2.0 broadhead screw

● Torx T8M2.5×7.0 screw (slotted)

● Torx T8M2.5×6.0 screw

● Torx T8M2.5×4.0 screw

● Torx T8M2.0×2.0 broadhead screw
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Spare part
number

Description

246959-001 Power cord for use in the United States

398393-002 Broadcom Bluetooth module for use in all countries and regions except Japan and Asia Pacific (does not
include the Bluetooth module cable) 

441075-001 Broadcom 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

441075-002 Broadcom 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands, the
Central African Republic, Chad, Chile, the People's Republic of China, Columbia, Comoros, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru,
the Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

441075-291 Broadcom 802.11a/b/g WLAN module for use in Japan

449137-001 RTC battery

450066-001 Broadcom Bluetooth module for use in Japan and Asia Pacific

459263-001 Broadcom 4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

459263-002 Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe
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461749-001 Modem module for use in all countries and regions except Australia and New Zealand

461749-011 Modem module for use in Australia and New Zealand

463955-001 90-W Slimline AC adapter (for use only with HP Compaq 6730s Notebook PC models in all countries and
regions except India)

463956-001 90-W Slimline AC adapter (for use only with HP Compaq 6730s Notebook PC models in India)

463958-001 65-W AC adapter

480985-001 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except Pakistan, Russia,
and the Ukraine

487330-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-002 Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

490324-001 Fan for use only with HP Compaq 6730s Notebook PC models 

490371-001 Power cord for use in the United States 

490371-011 Power cord for use in Australia and New Zealand

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom and Singapore

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea
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490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

491250-001 System Board (includes replacement thermal material and the ExpressCard assembly) for use only with
computer models equipped with Intel processors with UMA graphics subsystem memory 

491251-001 Webcam module for use only with HP Compaq 6730s Notebook PC models

491252-001 Base enclosure (includes rubber feet) for use only with HP Compaq 6730s Notebook PC models

491253-001 Plastics Kit for use only with HP Compaq 6730s Notebook PC models (see Plastics Kit on page 28 for more
Plastics Kit spare part information)

491254-001 Top cover (includes TouchPad board and cable, and TouchPad button board and cable)

491255-001 Heat sink for use only with HP Compaq 6730s Notebook PC models

491256-001 Display inverter for use only with HP Compaq 6730s Notebook PC models

491257-001 Display bezel and cover for use only with HP Compaq 6730s Notebook PC models not equipped with a
webcam

491258-001 Display bezel and cover with webcam for use only with HP Compaq 6730s Notebook PC models equipped
with a webcam

491259-001 Display Cable Kit for use only with HP Compaq 6730s Notebook PC models

491260-001 LCD miscellaneous for use only with HP Compaq 6730s Notebook PC models

491261-001 15.4-inch WXGA display assembly for use only with HP Compaq 6730s Notebook PC models

491262-001 15.4-inch WXGA BrightView display assembly for use only with HP Compaq 6730s Notebook PC models

491263-001 15.4-inch WXGA display assembly with webcam for use only with HP Compaq 6730s Notebook PC models

491264-001 15.4-inch WXGA BrightView display assembly with webcam for use only with HP Compaq 6730s Notebook
PC models

491265-001 120-GB, 5400-rpm hard drive for use only with HP Compaq 6730s Notebook PC models (includes hard drive
bracket)

491266-001 120-GB, 7200-rpm hard drive for use only with HP Compaq 6730s Notebook PC models (includes hard drive
bracket)

491267-001 160-GB, 5400-rpm hard drive for use only with HP Compaq 6730s Notebook PC models (includes hard drive
bracket)

491268-001 250-GB, 5400-rpm hard drive for use only with HP Compaq 6730s Notebook PC models (includes hard drive
bracket)

491269-001 Optical drive connector 

491270-001 DVD-ROM Drive for use only with HP Compaq 6730s Notebook PC models 

491271-001 DVD/CD-RW Combo Drive for use only with HP Compaq 6730s Notebook PC models

491272-001 DVD±RW Double-Layer Drive with LightScribe for use only with HP Compaq 6730s Notebook PC models

491273-001 Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer for use only with HP Compaq 6730s
Notebook PC models
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491274-001 Keyboard for use in the United States only with HP Compaq 6730s Notebook PC models 

491274-031 Keyboard for use in the United Kingdom only with HP Compaq 6730s Notebook PC models

491274-041 Keyboard for use in Germany only with HP Compaq 6730s Notebook PC models

491274-051 Keyboard for use in France only with HP Compaq 6730s Notebook PC models

491274-061 Keyboard for use in Italy only with HP Compaq 6730s Notebook PC models

491274-071 Keyboard for use in Spain only with HP Compaq 6730s Notebook PC models

491274-081 Keyboard for use in Denmark only with HP Compaq 6730s Notebook PC models

491274-091 Keyboard for use in Norway with HP Compaq 6730s and 6735s Notebook PC models

491274-121 Keyboard for use in French Canada only with HP Compaq 6730s Notebook PC models

491274-131 Keyboard for use in Portugal only with HP Compaq 6730s Notebook PC models

491274-141 Keyboard for use in Turkey only with HP Compaq 6730s Notebook PC models

491274-161 Keyboard for use in Latin America only with HP Compaq 6730s Notebook PC models

491274-171 Keyboard for use in Saudi Arabia only with HP Compaq 6730s Notebook PC models

491274-181 Keyboard for use in Belgium only with HP Compaq 6730s Notebook PC models

491274-201 Keyboard for use in Brazil only with HP Compaq 6730s Notebook PC models

491274-211 Keyboard for use in Hungary only with HP Compaq 6730s Notebook PC models

491274-221 Keyboard for use in the Czech Republic only with HP Compaq 6730s Notebook PC models

491274-231 Keyboard for use in Slovakia only with HP Compaq 6730s Notebook PC models

491274-251 Keyboard for use in Russia only with HP Compaq 6730s Notebook PC models

491274-281 Keyboard for use in Thailand only with HP Compaq 6730s Notebook PC models

491274-291 Keyboard for use in Japan only with HP Compaq 6730s Notebook PC models

491274-AB1 Keyboard for use in Taiwan only with HP Compaq 6730s Notebook PC models

491274-AD1 Keyboard for use in South Korea only with HP Compaq 6730s Notebook PC models

491274-B31 Keyboard for International use only with HP Compaq 6730s Notebook PC models

491274-B71 Keyboard for use in Finland only with HP Compaq 6730s Notebook PC models

491274-BA1 Keyboard for use in Slovenia only with HP Compaq 6730s Notebook PC models

491274-BB1 Keyboard for use in Israel only with HP Compaq 6730s Notebook PC models

491274-BG1 Keyboard for use in Switzerland only with HP Compaq 6730s Notebook PC models

491274-DD1 Keyboard for use in Iceland only with HP Compaq 6730s Notebook PC models

491274-DJ1 Keyboard for use in Greece only with HP Compaq 6730s Notebook PC models

491275-001 Rubber Kit (contains 7 computer feet and 8 display bezel screw covers) for use only with HP Compaq 6730s
Notebook PC models

491276-001 Screw Kit for use only with HP Compaq 6730s Notebook PC models

491277-001 Speaker Kit for use only with HP Compaq 6730s Notebook PC models 
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491278-001 6-cell, 47-Wh Li-ion battery for use only with HP Compaq 6730s Notebook PC models 

491279-001 8-cell, 63-Wh Li-ion battery for use only with HP Compaq 6730s Notebook PC models

491281-001 Logo Kit for use only with HP Compaq 6730s Notebook PC models

491282-001 Intel Celeron M 575 2.0-GHz processor (1-MB, L2 cache, 667-MHz FSB) for use only with HP Compaq 6730s
Notebook PC models

491283-001 Intel Celeron M 585 2.16-GHz processor (1-MB, L2 cache, 667-MHz FSB) for use only with HP Compaq 6730s
Notebook PC models

491284-001 Intel Core2 Duo P8400 2.26-GHz processor (3-MB, L2 cache, 1066-MHz FSB) for use only with HP Compaq
6730s Notebook PC models

491285-001 Intel Core2 Duo P8600 2.40-GHz processor (3-MB, L2 cache, 1066-MHz FSB) for use only with HP Compaq
6730s Notebook PC models

491286-001 Intel Core2 Duo T9400 2.53-GHz processor (6-MB, L2 cache, 1066-MHz FSB) for use only with HP Compaq
6730s Notebook PC models

491287-001 Cable Kit for use only with HP Compaq 6730s Notebook PC models (see Cable Kit on page 29 for more Cable
Kit spare part information)

491288-001 Switch cover (includes LED board and cable) for use only with HP Compaq 6730s Notebook PC models 

491476-001 Memory module, 1-GB, (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6730s Notebook PC
models 

491477-001 Memory module, 1-GB, (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6730s Notebook PC
models

491478-001 Memory module, 2-GB, (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6730s Notebook PC
models

491479-001 Memory module, 2-GB (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6730s Notebook PC
models

491578-001 AMD Sempron processor, SI-40, 2.0 GHz (512-KB, L2 cache, 25W) for use only with HP Compaq 6735s
Notebook PC models 

491579-001 AMD Athlon Dual-Core processor, QL-60, 1.9-GHz (1-MB, L2 cache, 35W) for use only with HP Compaq
6735s Notebook PC models

491580-001 AMD Turion Dual-Core processor, RM-70, 2.0-GHz (1-MB, L2 cache, 35W) for use only with HP Compaq
6735s Notebook PC models

491581-001 AMD Turion Ultra Dual-Core processor, ZM-80, 2.1-GHz (2-MB, L2 cache, 35W) for use only with HP Compaq
6735s Notebook PC models

491582-001 AMD Turion Ultra Dual-Core processor, ZM-82, 2.2-GHz (2-MB, L2 cache, 35W) for use only with HP Compaq
6735s Notebook PC models

491583-001 AMD Turion Ultra Dual-Core processor, ZM-86, 2.4-GHz (2-MB, L2 cache, 35W) for use only with HP Compaq
6735s Notebook PC models

491584-001 15.4-inch WXGA display assembly (includes 2 WLAN antenna transceivers and cables) for use in all countries
and regions except Brazil only with HP Compaq 6735s Notebook PC models

491585-001 15.4-inch WXGA display assembly (includes 2 WLAN antenna transceivers and cables) for use only in Brazil
with HP Compaq 6735s Notebook PC models

491586-001 15.4-inch WXGA display assembly with webcam (includes 2 WLAN antenna transceivers and cables) for use
only in Brazil with HP Compaq 6735s Notebook PC models
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491587-001 15.4-inch WXGA BrightView display assembly (includes 2 WLAN antenna transceivers and cables) for use
only with HP Compaq 6735s Notebook PC models

491588-001 15.4-inch WXGA BrightView display assembly (includes 2 WLAN antenna transceivers and cables) for use
only in Brazil with HP Compaq 6735s Notebook PC models

491589-001 15.4-inch WXGA BrightView display assembly with webcam (includes 2 WLAN antenna transceivers and
cables) for use only in Brazil with HP Compaq 6735s Notebook PC models

491591-001 1024-MB memory module (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6735s Notebook PC
models

491592-001 2048-MB memory module (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6735s Notebook PC
models

491594-001 1024-MB memory module (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6735s Notebook PC
models

491595-001 2048-MB memory module (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6735s Notebook PC
models

491596-001 120-GB, 5400-rpm hard drive for use only with HP Compaq 6735s Notebook PC models 

491597-001 160-GB, 5400-rpm hard drive for use only with HP Compaq 6735s Notebook PC models

491598-001 250-GB, 5400-rpm hard drive for use only with HP Compaq 6735s Notebook PC models

491599-001 DVD-ROM Drive for use only with HP Compaq 6735s Notebook PC models 

491600-001 DVD/CD-RW Combo Drive for use only with HP Compaq 6735s Notebook PC models 

491601-001 DVD±RW SuperMulti Double-Layer Drive with LightScribe for use only with HP Compaq 6735s Notebook PC
models 

491603-001 Keyboard for use in the United States only with HP Compaq 6735s Notebook PC models 

491603-031 Keyboard for use in the United Kingdom only with HP Compaq 6735s Notebook PC models

491603-041 Keyboard for use in Germany only with HP Compaq 6735s Notebook PC models

491603-051 Keyboard for use in France only with HP Compaq 6735s Notebook PC models

491603-061 Keyboard for use in Italy only with HP Compaq 6735s Notebook PC models

491603-071 Keyboard for use in Spain only with HP Compaq 6735s Notebook PC models

491603-081 Keyboard for use in Denmark only with HP Compaq 6735s Notebook PC models

491603-121 Keyboard for use in French Canada only with HP Compaq 6735s Notebook PC models

491603-131 Keyboard for use in Portugal only with HP Compaq 6735s Notebook PC models

491603-141 Keyboard for use in Turkey only with HP Compaq 6735s Notebook PC models

491603-151 Keyboard for use in Greece only with HP Compaq 6735s Notebook PC models

491603-161 Keyboard for use in Latin America only with HP Compaq 6735s Notebook PC models

491603-171 Keyboard for use in Saudi Arabia only with HP Compaq 6735s Notebook PC models

491603-201 Keyboard for use in Brazil only with HP Compaq 6735s Notebook PC models

491603-211 Keyboard for use in Hungary only with HP Compaq 6735s Notebook PC models

491603-221 Keyboard for use in Czech Republic only with HP Compaq 6735s Notebook PC models
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491603-231 Keyboard for use in Slovakia only with HP Compaq 6735s Notebook PC models

491603-251 Keyboard for use in Russiaonly with HP Compaq 6735s Notebook PC models

491603-281 Keyboard for use in Thailand only with HP Compaq 6735s Notebook PC models

491603-291 Keyboard for use in Japan only with HP Compaq 6735s Notebook PC models

491603-A41 Keyboard for use in Belgium only with HP Compaq 6735s Notebook PC models

491603-AB1 Keyboard for use in Taiwan only with HP Compaq 6735s Notebook PC models

491603-AD1 Keyboard for use in South Korea only with HP Compaq 6735s Notebook PC models

491603-B31 Keyboard for International use only with HP Compaq 6735s Notebook PC models

491603-B71 Keyboard for use in Finland only with HP Compaq 6735s Notebook PC models

491603-BA1 Keyboard for use in Slovakia only with HP Compaq 6735s Notebook PC models

491603-BB1 Keyboard for use in Israel only with HP Compaq 6735s Notebook PC models

491603-BG1 Keyboard for use in Switzerland only with HP Compaq 6735s Notebook PC models

491603-DD1 Keyboard for use in Iceland only with HP Compaq 6735s Notebook PC models

491604-001 Base enclosure (includes rubber feet) for use only with HP Compaq 6735s Notebook PC models 

481608-001 Cable Kit for use only with HP Compaq 6735s Notebook PC models (includes RJ-11 jack cable and USB
cable) 

491610-001 Display Hinge Kit for use only with HP Compaq 6735s Notebook PC models (includes left and right hinges) 

491612-001 Speakers for use only with HP Compaq 6735s Notebook PC models 

491613-001 Thermal module for use only with HP Compaq 6735s Notebook PC models 

491616-001 Plastics Kit for use only with HP Compaq 6735s Notebook PC models 

491617-001 Screw Kit for use only with HP Compaq 6735s Notebook PC models 

491620-001 Rubber Kit for use only with HP Compaq 6735s Notebook PC models 

491621-001 Fan for use only with HP Compaq 6735s Notebook PC models 

491622-001 Logo Kit for use only with HP Compaq 6735s Notebook PC models 

491976-001 System board (includes replacement thermal material and the ExpressCard assembly) for use only with HP
Compaq 6730s Notebook PC models equipped with Intel processors with discrete graphics subsystem
memory (includes 256-MB of graphics subsystem memory)

491979-001 Thermal module for use only with HP Compaq 6730s Notebook PC models equipped with discrete graphics
subsystem memory 

494106-01 System board (includes replacement thermal material and the ExpressCard assembly) for use only with HP
Compaq 6735s Notebook PC models equipped with UMA graphics subsystem memory 

494108-001 Display bezel and cover for use only with HP Compaq 6735s Notebook PC models not equipped with a
webcam 

494109-001 Display bezel and cover for use only with HP Compaq 6735s Notebook PC models equipped with a
webcam 

494110-001 Webcam with module board for use only with HP Compaq 6735s Notebook PC models 

494114-001 Display Cable Kit for use only with HP Compaq 6735s Notebook PC models 
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494115-001 Switch cover (includes LED power button board and cable) for use only with HP Compaq 6735s Notebook PC
models

494116-001 Display inverter (includes cable) for use only with HP Compaq 6735s Notebook PC models

496677-001 Intel Core2 Duo T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB) (socketed) (not available for
Japan) 

496678-001 Intel Core2 Duo T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB) (socketed) (not available for
Japan)

496679-001 Thermal module for use only with HP Compaq 6730s Notebook PC models equipped with Intel processors
and UMA graphics subsystem memory 

496680-001 Display hinges (15-in) for use only with HP Compaq 6730s Notebook PC models

496897-001 8-cell 63-Wh Li-ion battery for use only with HP Compaq 6735s Notebook PC models

500328-001 Display miscellaneous (includes a 15-inch display miscellaneous assembly, aluminum foil shield, and tape)
for use only with HP Compaq 6735s Notebook PC models

501354-001 System board GL45 (includes replacement thermal material and the ExpressCard assembly) for use only with
HP Compaq 6730s Notebook PC models equipped with Intel processors with UMA graphics subsystem
memory

501870-001 6-cell 47-Wh Li-ion battery for use only with HP Compaq 6735s Notebook PC models

506278-001 AMD Athlon Dual-Core QL-62 2.0-GHz processor (1-MB L2 cache, 35W) for use only with HP Compaq 6735s
Notebook PC models

506279-001 AMD Turion Dual-Core RM-72 2.1-GHz processor (1-MB, L2 cache, 35W) for use only with HP Compaq 6735s
Notebook PC models 

506280-001 AMD Turion Ultra Dual-Core ZM-84 2.3-GHz processor (2-MB L2 cache, 35W) for use only with HP Compaq
6735s Notebook PC models

506449-001 Intel Celeron Dual-Core T1600 1.66-GHz processor (1-MB L2 cache, 667-MHz FSB) for use only with HP
Compaq 6730s Notebook PC models 

506450-001 Intel Celeron Dual-Core T1700 1.83-GHz processor (1-MB L2 cache, 667-MHz FSB) for use only with HP
Compaq 6730s Notebook PC models

506451-001 Intel Core2 Duo P7370 2.0-GHz processor (3-MB L2 cache, 1066-MHz FSB) for use only with HP Compaq
6705s Notebook PC models (only available with Intel WLAN) 

506452-001 160-GB, 7200-rpm hard drive for use only with HP Compaq 6730s Notebook PC models (includes hard drive
bracket) 

510176-001 320-GB, 5400-rpm hard drive for use only with HP Compaq 6730s Notebook PC models (includes hard drive
bracket) 
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 80).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This section provides removal and replacement procedures.

There are as many as 76 screws, in 16 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag location
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part numbers 491257-001 (for use only with HP Compaq 6730s Notebook PC models) and 491620-001
(for use only with HP Compaq 6735s Notebook PC models). There are 7 rubber feet that attach to the
base enclosure in the locations illustrated below.
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Battery

Description Spare part number

8-cell, 63-Wh Li-on battery

For use only with HP Compaq 6730s Notebook PC models 491279-001

For use only with HP Compaq 6735s Notebook PC models 496897-001

6-cell, 47-Wh Li-on battery

For use only with HP Compaq 6730s Notebook PC models 491278-001

For use only with HP Compaq 6735s Notebook PC models 501870-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models

320-GB, 5400-rpm hard drive 510176-001

250-GB, 5400-rpm hard drive 491268-001

160-GB, 7200-rpm hard drive 506452-001

160-GB, 5400-rpm hard drive 457014-001

120-GB, 5400-rpm hard drive 491267-001

120-GB, 7200-rpm hard drive 491266-001

120-GB, 5400-rpm hard drive 491265-001

For use only with HP Compaq 6735s Notebook PC models

250-GB, 5400-rpm hard drive 491598-001

160-GB, 5400-rpm hard drive 491597-001

120-GB, 5400-rpm hard drive 491596-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.5×6.0 captive screws (1) that secure the hard drive bay cover to the
computer.
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3. Lift the right side of the hard drive bay cover (2), swing it to left, and remove the cover (3). The hard
drive bay cover is included in the Plastics Kit, spare part numbers 491253-001 (for HP Compaq
6730s Notebook PC models) and 491616-001 (for HP Compaq 6735s Notebook PC models).

4. Loosen the Phillips PM2.5×10.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab on the hard drive and slide the hard drive (2) to the left to disconnect it from
the system board.

6. Remove the hard drive (3) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except
Pakistan, Russia, and the Ukraine

480985-001

Broadcom BCM4312 802.11b/g WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

459263-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

Broadcom BCM4322 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-001

54 Chapter 4   Removal and replacement procedures



Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

Broadcom 802.11a/b/g WLAN modules:

For use only on HP Compaq 6735s Notebook PC models  

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441075-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

● For use in Japan 441075-291
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Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the WLAN module compartment
cover to the computer.

3. Lift the right side of the WLAN module compartment cover (2), swing it to the left, and remove the
cover. The WLAN module compartment cover is included in the Plastics Kit, spare part numbers
491253-001 (for use only with HP Compaq 6730s Notebook PC models) and 491616-001 (for use
only with HP Compaq 6735s Notebook PC models.

4. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

5. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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6. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.

Memory module

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models

2-GB (PC2-6400, 800-MHz, DDR2) 491479-001

1-GB (PC2-6400,800-MHz, DDR2) 491477-001

2-GB (PC2-5300, 667-MHz, DDR2) 491478-001

1-GB (PC2-5300, 667-MHz, DDR2) 491476-001

For use only with HP Compaq 6735s Notebook PC models

2048-MB (PC2-6400, 800-MHz, DDR2) 491595-001

1024-MB (PC2-6400, 800-MHz, DDR2) 491594-001

2048-MB (PC2-5300, 667-MHz, DDR2) 491592-001

1024-MB (PC2-5300, 667-MHz, DDR2) 491591-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Component replacement procedures 57



Remove the memory module:

1. Loosen the Phillips PM2.0×6.0 captive screw (1) that secures the memory module compartment
cover to the computer.

2. Lift the front edge of the cover (2), swing it up and back, and remove the cover. The memory module
compartment cover is included in the Plastics Kit, spare part numbers 491253-001 (for use only
with HP Compaq 6730s Notebook PC models) and 491616-001 (for use only with HP Compaq
6735s Notebook PC models).

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models

DVD±RW Double-Layer Drive with LightScribe 491272-001

Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer 491273-001

DVD/CD-RW Combo Drive 491271-001

DVD-ROM Drive 491270-001

For use only with HP Compaq 6735s Notebook PC models

DVD±RW SuperMulti Double-Layer Drive with LightScribe 491601-001

DVD/CD-RW Combo Drive 491600-001

DVD–ROM Drive 491599-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the slotted Torx T8M2.5×7.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Switch cover and keyboard

Description Spare part number

Switch covers (includes LED button board and cable)

For use only with HP Compaq 6730s Notebook PC models 491288-001

For use only with HP Compaq 6735s Notebook PC models 494115-001

Keyboards for use only with HP Compaq 6730s Noteboook PC models

Belgium 491274-201 Latin America 491274-161

For International use 491274-B31 Norway 491274-091

The Czech Republic 491274- Portugal 491274-131

Denmark 491274-081 Russia 491274-251

France 491274-051 Saudi Arabia 491274-171

French Canada 491274-121 Slovakia 491274-231

Finland 491274-B71 Slovenia 491274-BA1

Germany 491274-041 Spain 491274-071

Greece 491274-DJ1 Switzerland 491274-BG1

Hungary 491274-211 Thailand 491274-281

Iceland 491274-DD1 Turkey 491274-141

Israel 491274-BB1 Taiwan 491274-AB1

Italy 491274-061 United Kingdom 491274-031

Japan 491274-291 United States 491274-001

South Korea 491274-AD1   

Keyboards for use only with HP Compaq 6735s Notebook PC models

Belgium 491603-A41 South Korea 491603-AD1

Brazil 491603-201 Latin America 491603-161

Czech Republic 491603-221 Norway 491603-091

Denmark 491603-081 Portugal 491603-131

Finland 491603-B71 Russia 491603-251

France 491603-051 Saudi Arabia 491603-171

French Canada 491603-121 Slovakia 491603-231

Germany 491603-041 Slovenia 491603-BA1

Greece 491603-151 Spain 491603-071

Hungary 491603-211 Switzerland 491603-BG1

Iceland 491603-DD1 Thailand 491603-281

Israel 491603-BB1 Taiwan 491603-AB1

Italy 491603-061 Turkey 491603-141
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Description Spare part number

International use 491603-B31 United Kingdom 491603-031

Japan 491603-291 United States 491603-001

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the switch cover and keyboard:

1. Remove the following screws:

(1) Two slotted Torx T8M2.5×7.0 screws

(2) Three Torx T8M2.0×2.0 broadhead screws
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2. Remove the two slotted Torx T8M2.5×7.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the switch cover (1) up and forward until it disengages from the computer, and slide it back
(2) until it rests on the display assembly.
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6. To disengage the four tabs (1) on the front of the keyboard from the computer, lift up the rear edge
of the keyboard (2) until it rests at an angle, and then slide it back (3) until it rests on the display
assembly and switch cover.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.
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9. Disconnect the button board cable (1) from the system board, and remove the switch cover (2).

10. Turn the switch cover over.

11. Remove the two Phillips PM2.0x2.0 broadhead screws (1) from the switch cover.

12. Remove the LED power button board (2) from the switch cover.

Reverse this procedure to install the switch cover and keyboard.
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Speakers

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models 491277-001

For use only with HP Compaq 6735s Notebook PC models 491612-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 61).

Remove the speakers:

1. Disconnect the speaker cable (1) from the system board and remove the speaker cable from the
clips and routing channel.

NOTE: The two speakers are connected with a single cable.

2. Remove the four Phillips PM2.5×4.0 screws (2) that secure the speakers to the top cover.

3. Remove the speakers (3) from the top cover.

Reverse this procedure to install the speakers.
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Display assembly
NOTE: All display assembly spare part kits include 2 WLAN antenna transceivers and cables.

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models

15.4-inch WXGA BrightView display assembly for use in all countries and regions except Brazil on
computer models equipped with a webcam

491264-001

15.4-inch WXGA BrightView display assembly for use in all countries and regions except Brazil on
computer models not equipped with a webcam

491262-001

15.4-inch WXGA display assembly for use in all countries and regions except Brazil on computer
models equipped with a webcam

491263-001

15.4-inch WXGA display assembly for use in all countries and regions except Brazil on computer
models not equipped with a webcam

491261-001

For use only with HP Compaq 6735s Notebook PC models

15.4-inch WXGA BrightView display assembly for use in all countries and regions except Brazil on
computer models not equipped with a webcam

491587-001

15.4-inch WXGA display assembly for use in all countries and regions except Brazil on computer
models not equipped with a webcam

491584-001

15.4-inch WXGA display assembly for use on computer models not equipped with a webcam (for
use only in Brazil)

491585-001

15.4-inch WXGA display assembly for use on computer models equipped with a webcam (for use
only in Brazil)

491586-001

15.4-inch WXGA BrightView display assembly for use on computer models not equipped with a
webcam (for use only in Brazil)

491588-001

15.4-inch, WXGA BrightView display assembly for use on computer models equipped with a webcam
(for use only in Brazil)

491589-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 61)

b. Speakers (see Speakers on page 66)
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Remove the display cable:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.

3. Disconnect the display panel cable (1) from the system board.

CAUTION: There is a ground loop off the display panel cable that is secured to the left hinge. Be
sure you do not pull or damage the cable.

4. Disconnect the camera and microphone module cables (2) from the system board, and then
remove the cables from the routing path (3).

5. Remove the wireless antenna cables (4) from the clips and routing channels built into the top cover.

Remove the display assembly:

CAUTION: The display assembly will be unsupported when the following screws are removed. To
prevent damage to the display assembly, support it before removing the screws.

1. Remove the four slotted Torx T8M2.5×7.0 screws (1) that secure the display assembly to the
computer.

CAUTION: There is a ground loop off the display panel cable (2) that is secured to the left hinge.
Be sure you do not pull or damage the cable.
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2. Lift the display assembly (3) straight up and remove it.

3. If it is necessary to replace the display bezel, display inverter, or display hinges, remove the eight
rubber screw covers (1) and the eight Torx T8M2.5×6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part
numbers 491257-001 (for use only with HP Compaq 6730s Notebook PC models) and 491620-001
(for use only with HP Compaq 6735s Notebook PC models).

4. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.
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5. Remove the display bezel (3). The display bezel is available using spare part numbers 491257-001
(for use only with HP Compaq 6730s Notebook PC models without a webcam), 491258-001 (for
use only with HP Compaq 6730s Notebook PC models with a webcam), 494109-001 (for use only
with HP Compaq 6735s Notebook PC models with a webcam), and 494108-001 (for use only with
HP Compaq 6735s Notebook PC models without a webcam).

6. If it is necessary to replace the webcam module from the display enclosure, gently pull the webcam
module away from the double-sided tape on the display enclosure (1) and disconnect the webcam
cable from the module (2). The webcam module can be ordered by using spare part numbers
491251-001 (for use only with HP Compaq 6730s Notebook PC models) and 494110-001 (for use
only with HP Compaq 6735s Notebook PC models).

NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

7. If it is necessary to replace the display inverter, remove the inverter (1) from the display enclosure
as far as the display panel cable and the backlight cable will allow.
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8. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

9. Remove the display inverter. The display inverter is available using spare part numbers
491256-001 (for use only with HP Compaq 6730s Notebook PC models) and 494116-001 (for use
only with HP Compaq 6735s Notebook PC models).

10. If it is necessary to replace the display hinges, remove the two Torx T8M2.5×6.0 screws (1) and
the two Torx T8M2.5×5.0 screws (2) that secure the display panel to the display enclosure.

11. Remove the display panel (3).

12. Remove the four Phillips PM2.0×3.0 screws (1) that secure each display hinge to the display
panel.

NOTE: When removing or replacing the eight Phillips screws, be sure to remove or replace them
in the same sequence as the numbering found on the display hinges (1–2–3–4).
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13. Remove the display hinges (2). The left and right display hinges are available in the Hinge Kit,
spare part numbers 496680-001 (for use only with HP Compaq 6730s Notebook PC models) and
491610-001 (for use only with HP Compaq 6735s Notebook PC models).

14. If it is necessary to replace the wireless antenna cables, remove the two Torx T8M2.5×4.0
screws (1) that secure the wireless antenna transceiver to the top cover. The wireless antenna
cables are included in the Display Cable Kit, spare part numbers 491259-001 (for use only with HP
Compaq 6730s Notebook PC models) and 494114-001 (for use only with HP Compaq 6735s
Notebook PC models).

15. Remove the wireless antenna (2).

16. Remove the wireless antenna cables (3) from the clips and routing channels built into the top cover.
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17. If it is necessary to replace the webcam cable from the display enclosure, gently pull the webcam
cables (1) from the clips and routing channels (2) built into the top cover. The webcam cable is
included in the Display Cable Kit, spare part numbers 491259-001 (for use only with HP Compaq
6730s Notebook PC models) and 494114-001 (for use only with HP Compaq 6735s Notebook PC
models).

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover (includes TouchPad board and cable, and TouchPad button board and cable) 491254-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the two rubber screw covers (1) and the seven slotted Torx ST8M2.5×7.0 screws (2) that
secure the top cover to the computer. The rubber screw covers are available in the Rubber Kit,
spare part numbers 491257-001 (for use only with HP Compaq 6730s Notebook PC models) and
491620-001 (for use only with HP Compaq 6735s Notebook PC models).
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3. Remove the three Phillips PM2.0×2.0 broadhead (5-mm) screws from the optical drive bay (1), and
remove the Torx T8M2.5x4.0 screw from the hard drive bay (2).

4. Turn the computer right-side up.

5. Remove the three slotted Torx T8M2.5×7.0 screws from the top cover.
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6. Lift the rear edge of the top cover (1) until it disengages from the base enclosure, and then slide
the top cover (2) back until the TouchPad cable is accessible.

7. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
TouchPad cable from the system board (2).

8. Remove the top cover.

Reverse this procedure to install the top cover.
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USB connector module
1. Disconnect the USB cable from the system board (1).

2. Lift up the USB connector and remove the cable from the front edge of the base enclosure (2).

3. Remove the long Phillips PM2.5×9.0 screw (3) and the short Torx T8M2.5×4.0 screw (4) from the
system board.

4. Remove the USB connector module (5).

Reverse this procedure to install the USB connector module.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 457400-001. See Cable Kit on page 29
for more Cable Kit spare part number information.

Description Spare part number

For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

For use only in Japan and Asia Pacific countries and regions 450066-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Remove the Bluetooth module cable (2) from the routing path.

3. Remove the Phillips PM2.0×4.0 screw (3) that secures the Bluetooth module to the base enclosure.
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4. Remove the Bluetooth module (4) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

Component replacement procedures 79



RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

Remove the RTC battery:

1. Turn the system board upside down, with the audio connectors toward you.

2. Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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Fan

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models 490324-001

For use only with HP Compaq 6735s Notebook PC models 491621-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

Remove the fan:

1. Remove the two Torx T8M2.5×6.0 screws (1) that secure the fan to the base enclosure.

2. Lift the fan up (2) from the base enclosure.
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Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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System board
NOTE: The system board spare part kit includes the ExpressCard assembly and replacement thermal
material.

Description Spare part number

For use only with HP Compaq 6730s Notebook PC models

For use only with computer models equipped with Intel processors (includes 256-MB of discrete
graphics subsystem memory)

491976-001

For use only with computer models equipped with Intel processors with UMA graphics subsystem
with a GL40 system board

491250-001

For use only with computer models equipped with Intel processors with UMA graphics subsystem
and a GL45 system board

501354-001

For use only with HP Compaq 6735s Notebook PC models

For use only with computer models equipped with AMD processors with UMA graphics subsystem 494106-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

g. USB connector module (see USB connector module on page 77)

h. Bluetooth module (see Bluetooth module on page 78)

i. Fan (see Fan on page 81)

j. RTC battery (see RTC battery on page 80)
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When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory module (see Memory module on page 57)

● WLAN module (see WLAN module on page 54)

● Processor (see Processor on page 92)

Remove the system board:

1. Disconnect the Bluetooth module cable (1), and the fan cable (2) from the system board.

2. Disconnect the USB connector module cable (3) from the system board, and remove the RJ-11
connector (4) from the base enclosure clip.

3. Remove the two Phillips 2.0x4.0 screws (1) and the Torx T8M2.5×6.0 screw (2) from the system
board.

4. Flex the left side of the base enclosure until the external monitor connector (1) and the heat sink
(2) are clear of the openings in the base enclosure.

5. Lift the rear edge of the system board (3) until it rests at an angle.
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6. Remove the system board (4) from the base enclosure by sliding it back.

Reverse this procedure to install the system board.
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Modem module

Description Spare part number

For use in all countries and regions except Australia and New Zealand 461749-001

For use only in Australia and New Zealand 461749-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

g. System board (see System board on page 83)

Remove the modem module:

1. Turn the system board upside down, with the audio connectors toward you.

2. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system board.

3. Lift the modem module (2) straight up to disconnect it from the system board.
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4. Disconnect the modem module cable (3).

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Heat sink
NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

For use only with HP Compaq 6735s Notebook PC models 491613-001

For use only with HP Compaq 6730s Notebook PC models 491979-001

For use only with HP Compaq 6730s Notebook PC models 496679-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

g. System board (see System board on page 83)

Remove the heat sink:

NOTE: Steps 1 through 3 apply only to HP Compaq 6730s Notebook PC models with discrete
subsystem memory on the system board. See steps 4 through 6 for removing the heat sink on HP
Compaq 6730s Notebook PC models with Intel processor and UMA subsystem memory. See steps 7
through 9 for removing the heat sink on HP Compaq 6735s Notebook PC models with AMD processor
and UMA subsystem memory.

1. Turn the system board upside down, with the audio connectors toward you.

2. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four screws (1) around
the processor.
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3. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system
board (1) and (2), and the heat sink components (3) and (4) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

NOTE: Steps 4 through 6 apply only to HP Compaq 6730s Notebook PC models with Intel
processors with UMA subsystem memory. See steps 1 through 3 for removing the heat sink on HP
Compaq 6730s Notebook PC models with discrete subsystem memory. See steps 7 through 9 for
removing the heat sink on HP Compaq 6735s Notebook PC models with AMD processors with
UMA subsystem memory.

4. Turn the system board upside down, with the audio connectors toward you.

5. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the six screws (1) around the
processor.
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6. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system
board (1), (2), and (3), and the heat sink components (4), (5), and (6) each time the heat sink is
removed. Replacement thermal material is included with all heat sink, system board, and processor
spare part kits.

NOTE: Steps 7 through 9 apply only to HP Compaq 6735s Notebook PC models with AMD
processors and UMA subsystem memory.

7. Turn the system board upside down, with the audio connectors toward you.

8. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the five screws (1) around the
processor.
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9. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system
board (1) and (2), and the heat sink components (3) and (4) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

AMD processors for use only with HP Compaq 6735s computer models  

Turion Ultra ZM-86 2.40-GHz processor 491583-001

Turion Ultra ZM-84 2.30-GHz processor 506280-001

Turion Ultra ZM-82 2.20-GHz processor 491582-001

Turion Ultra ZM-80 2.10-GHz processor 491581-001

Turion RM-72 2.1GHz (35W 1-MB L2 cache) 506279-001

Turion RM-70 2.0-GHz processor (1-MB L2 cache, 35W) 491580-001

Athlon QL-60 1.9-GHz processor (1-MB L2 cache, 35W) 491579-001

Athlon QL-62 2.0-GHz processor (1-MB L2 cache, 35W) 506278-001

Sempron SI-40 2.00-GHz processor (512-KB L2 cache, 25W) 491587-001

Intel Core2 Duo processors for use only with HP Compaq 6730s computer models  

T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB) (not available for Japan) 496677-001

T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB) (not available for Japan) 496678-001

P7370 2.0-GHz processor (3.0-MB L2 cache, 1066-MHz FSB) 506451-001

P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 491284-001

P8600 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 491285-001

T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 491286-001

Intel Celeron M Processors for use only with HP Compaq 6730s computer models  

575 2.0-GHz processor (1-MB L2 cache, 667-MHz FSB) 491282-001

585 2.16-GHz processor (1-MB L2 cache, 667-MHz FSB) 491283-001

Intel Celeron Dual-Core processors for use only with HP Compaq 6730s computer models  

T1600 1.66-GHz processor (1-MB L2 cache, 667-MHz FSB) 506449-001

T1700 1.83-GHz processor (1-MB L2 cache, 667-MHz FSB) 506450-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:
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a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 59)

c. Switch cover and keyboard (see Switch cover and keyboard on page 61)

d. Speakers (see Speakers on page 66)

e. Display assembly (see Display assembly on page 67)

f. Top cover (see Top cover on page 74)

g. System board (see System board on page 83)

Remove the processor:

NOTE: Steps 1 through 3 apply only to HP Compaq 6730s models. See steps 4 and 5 for instructions
on removing the processor on HP Compaq 6735s models.

1. Turn the system board upside down, with the USB connectors toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

3. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

NOTE: Steps 4 and 5 apply only to HP Compaq 6735s models. See steps 1 through 3 for
instructions on removing the processor on HP Compaq 6530s and 6531s models.

4. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.
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5. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
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To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this

System Diagnostics menu ● F1 System Information—Displays the following
information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● F2 Start-up Test—Verifies the system components
needed for starting the computer.

● F3 Run-In Test—Runs a comprehensive check on
system memory.

● F4 Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

● F5 Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

◦ Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

● Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN when
not in use (enabled by default).

● Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)
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Select To do this

NOTE: Availability of the options above varies by
computer model.

● Enable/disable secondary battery fast charge (enabled by
default).

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel® Trusted Execution
Technology) (select models only; disabled by default).

● Enable/disable Dual Core CPU (select models only;
enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (select
models only; enabled by default).

● Enable/disable embedded Bluetooth® device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled by
default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable the ambient light sensor (enabled by default).

● Enable/disable the Notebook Multibay device (enabled by
default).

● Enable/disable the integrated camera (select models
only; enabled by default).

102 Chapter 5   Computer Setup



Select To do this

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the Smart Card slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

AMT Options NOTE: All AMT options are disabled by default.

● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (CTRL-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on Next Boot.

● Enable/disable Terminal Emulation Mode

● Enable/disable Firmware Progress Event Support.

● Enable/disable include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 26.67 cm 10.5 in

Width 35.84 cm 14.1 in

Height (front to rear) 3.23 to 3.58 cm 1.27 to 1.41 in

Weight (equipped with optical drive, WXGA display assembly,
1 memory module, hard drive, and 6-cell battery)

2.49 kg 5.5 lbs

Input power

Operating voltage 18.5 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

15.4-inch WXGA display specifications
 Metric U.S.

Dimensions

Height 20.7 cm 8.1 in

Width 33.1 cm 13.0 in

Diagonal 39.1 cm 15.4 in

Number of colors Up to 16.8 million

Contrast ratio 300:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight CCFL

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-30° horizontal, +10/–40° vertical (typical)
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Hard drive specifications
 320-GB* 250-GB* 160-GB* 120-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 625,141,400 488,376,280 312,560,640 234,420,480

Disc rotational speed 5400 rpm 5400 rpm 7200 rpm and
5400 rpm

7200 rpm and
5400 rpm

Operating temperature   5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD-ROM Drive specifications
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,

CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R, CD-
RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s
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DVD±RW Double-Layer Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD±RW SuperMulti Double-Layer Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW
Double-Layer specifications

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-
R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

DVD/CD-RW Combo Drive specifications 111



System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This chapter provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part numbers
491276-001 (for use only with HP Compaq 6730s Notebook PC models) and 491617-001 (for use only
with HP Compaq 6735s Notebook PC models).

Slotted Torx T8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 18 7.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Seven screws that secure the top cover to the computer
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Where used:

(1) Two screws that secure the switch cover to the computer

(2) Two screws that secure the keyboard to the computer

Where used: 4 screws that secure the display assembly to the computer
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Where used: 3 screws that secure the top cover to the base enclosure
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 10 3.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 8 screws that secure the display hinges to the display assembly
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Phillips PM2.5×6.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 6.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two captive screws that secure the hard drive bay cover to the computer (screws are secured by C-
clips)

(2) One captive screw that secures the WLAN module compartment cover to the computer (screw is
secured by a C-clip)

(3) One captive screw that secures the memory module compartment cover to the computer (screw is
secured by a C-clip)
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Phillips PM2.5×10.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 10.0 mm 2.5 mm 5.0 mm

Where used: One captive screw that secures the hard drive to the computer (screw is secured to the
hard drive bracket)
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Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the system board

Color Quantity Length Thread Head diameter

Black 2 4.0 mm 2.5 mm 5.0 mm
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Where used: 2 screws that secure the modem module to the system board
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Torx T8M2.0×2.0 broadhead screw (9-mm)

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 9.0 mm

Where used: 3 screws that secure the switch cover to the computer
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Phillips PM2.0×2.0 broadhead screw (6-mm)

Color Quantity Length Thread Head diameter

Black 2 2.0 mm 2.0 mm 6.0 mm

Where used: 2 screws that secure the button board to the switch cover
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Torx T8M2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 1 4.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the top cover to the base enclosure
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Torx T8M2.5×6.0 screw

Color Quantity Length Thread Heat width

Black 13 6.0 mm 2.5 mm 5.0 mm

Where used: 8 screws that secure the display bezel to the display assembly

Where used: 2 screws that secure the display panel to the display assembly
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Where used: One screw that secures the system board to the base enclosure

Where used: 2 screws that secure the fan to the base enclosure

130 Chapter 7   Screw listing



Torx T8M2.5x5.0 screw

Color Quantity Length Thread Head diameter

Black 2 5.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the display panel to the display assembly
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Phillips PM2.5x4.0 screw

Color Quantity Length Thread Head diameter

Black 7 4.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the speakers to the computer

Where used: 2 screws that secure the wireless antenna transceiver to the display enclosure
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Where used: One screw that secures the USB board to the system board
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Phillips PM2.0×2.0 broadhead screw (5-mm)

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 5.0 mm

Where used: 3 screws that secure the top cover to the display enclosure
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Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the TouchPad bracket and TouchPad button board to the top cover

Color Quantity Length Thread Head diameter

Black 3 4.0 mm 2.0 mm 4.5 mm
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Where used: 2 screws that secure the optical drive connector board to the system board

Where used: One screw that secures the Bluetooth module to the base enclosure
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Phillips PM2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 1 9.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the USB board to the system board
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Phillips PM2.5×10.0 captive screw

Color Quantity Length Thread Head diameter

Silver 16 10.0 mm 2.5 mm 5.0 mm

Where used: 4 captive screws that secure the discrete heat sink to the PM45 system board for use only
with HP Compaq 6730s Notebook PC models (screws are secured to the heat sink by C-clips)
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Where used: 6 captive screws that secure the heat sink to the GL40 or GM45 system boards for use
only with the HP Compaq 6730s Notebook PC models (screws are secured to the heat sink by C-clips)

Where used: 6 captive screws that secure the heat sink to the system board for use only with HP
Compaq 6735s Notebook PC models (screws are secured to the heat sink by C-clips)
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8 Backup and recovery

Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery 
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
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NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

External monitor
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Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.

154 Chapter 11   Recycling



10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part

numbers 32
AMT options

AMT setup prompt
(CTRL-P) 103

firmware progress event
support 103

firmware verbosity 103
terminal emulation mode 103
TYPE-131 in SMBIOS 103
unconfigure AMT on next

boot 103
USB key provisioning

support 103
antenna, disconnecting 56
audio, product description 5
audio-in jack

location 14
pin assignments 146

audio-out jack
location 14
pin assignments 146

B
backing up, Windows Vista 140
backing up, Windows XP 144
Backup and Restore

Center 140,  141
base enclosure, spare part

number 24,  36,  40
battery

location 16
removal 50
spare part number 24,  38, 

41,  50
battery bay 16
battery latches 16
battery light 15
BIOS administrator password 99

Blu-ray Disc ROM Combo Drive
removal 59
spare part number 27,  30, 

36,  59
specifications 110

Bluetooth module
removal 78
spare part number 22,  34, 

78
Bluetooth module cable

illustrated 29
boot options 101
boot order 101
bottom components 16
Broadcom Bluetooth module

spare part number 22
built-in device

ambient light sensor 102
Bluetooth device radio 102
embedded WLAN 102
fingerprint reader 102
integrated camera 102
LAN/WLAN switching 102
modem 102
Network Interface Controller

(LAN) 102
Notebook Multibay 102
Wake on LAN 102
wireless button 102
WWAN device radio 102

built-in device options 102
button components 11
buttons

power 12
TouchPad 10
wireless 11

C
Cable Kit

contents 29
spare part number 29,  38, 

40
cables, service considerations 43
caps lock light 12
chipset, product description 2
CMOS clearing 47
components

bottom 16
buttons 11
display 9
front 14
keys 12
left-side 15
lights 11
pointing devices 10
right-side 14
speakers 11
top 9
TouchPad 10

computer feet
locations 49
spare part number 49

Computer Setup
accessing 95
Diagnostics menu 100
File menu 98
navigating and selecting 96
restoring factory settings 96
Security menu 99
System Configuration

menu 101
using 96

computer specifications 104
connectors

power 15
service considerations 43
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D
device configurations 101
Diagnostics menu 100
discs

Driver Recovery 145
Operating System 145

Disk Sanitizer 99
diskette drive

precautions 43
product description 5

display
components 9
illustrated 9

display assembly
removal 67
spare part numbers 18,  19, 

36,  67
display bezel

removal 69
spare part number 19,  36, 

40,  70
display bezel with webcam, spare

part number 19
display cable kit, spare part

number 19,  36,  40
display component recycling 152
display components 9
display cover, spare part

number 19,  40
display hinge

removal 71
spare part number 19,  41, 

72
display inverter

removal 70
spare part number 19,  71

display inverter, spare part
number 41

display panel, removal 71
display specifications 105
drive light 14
DriveLock password 99
DriveLock, automatic 99
Driver Recovery disc 145
drives

boot order 101
preventing damage 43

Dual Core CPU 102
DVD-ROM Drive

removal 59

spare part number 27,  30, 
36,  39,  59

specifications 107
DVD/CD-RW Combo Drive

precautions 43
removal 59
spare part number 27,  30, 

36,  39,  59
specifications 111

DVD±RW Double-Layer Drive with
LightScribe

precautions 43
removal 59
spare part number 27,  30, 

36,  59
specifications 108

DVD±RW SuperMulti Double-Layer
Drive with LightScribe

removal 59
spare part number 27,  30, 

39,  59
specifications 109

E
electrostatic discharge 44
error log 100
esc key 12
Ethernet, product description 5
Execution Disable 101
ExpressCard assembly, spare part

number 23
ExpressCard slot 15
ExpressCard slot bezel 22
ExpressCard slot bezel,

illustrated 28
external media cards, product

description 5
external monitor port

location 15
pin assignments 146

F
fan

removal 81
spare part number 22,  35, 

40,  81
feet

locations 49
spare part number 49

File menu 98

fn key 13
front components 14
function keys 13

G
graphics, product description 2
grounding equipment and

methods 46

H
hard disk test 100
hard drive

location 16
precautions 43
product description 4
removal 51
spare part numbers 26,  30, 

36,  39,  41,  51
specifications 106

hard drive bay 16
hard drive bay cover

illustrated 28
removal 52

hard drive bracket, removal 53
headphone jack

location 14
pin assignments 146

heat sink
removal 88
spare part number 22,  36, 

88
hinge

removal 71
spare part number 72

Hinge Kit, spare part number 40
HP QuickLook 2 102
HP SpareKey enrollment 99

I
I/O address specifications 114
internal display switch 12
interrupt specifications 113

J
jacks

audio-in 14
audio-out 14
headphone 14
microphone 14
modem 15
network 15
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RJ-11 15
RJ-45 15

K
key components 12
keyboard

product description 6
removal 61
spare part number 20,  37, 

39,  61
keypad keys 13
keys

esc 12
fn 13
function 13
keypad 13
num lk 13
Windows applications 13
Windows logo 13

L
LAN Power Save 101
language, changing in Computer

Setup 101
LCD inverter, spare part

number 36
left-side components 15
legacy support, USB 95,  101
light components 11
lights

battery 15
caps lock 12
drive 14
power 11
wireless 11

Logo Kit, spare part number 32, 
38,  40

M
mass storage devices, spare part

numbers 30
Media Card Reader 14
memory map specifications 116
memory module

product description 3
removal 57
spare part numbers 26,  38, 

39,  57
memory module compartment 16

memory module compartment
cover

illustrated 28
removal 58

microphone jack
location 14
pin assignments 146

microphone, internal 14
model name 1
modem jack

location 15
pin assignments 148

modem module
product description 5
removal 86
spare part numbers 24,  86

monitor port
location 15
pin assignments 146

N
network jack

location 15
pin assignments 149

num lk key 13

O
Operating System disc 145
operating system, product

description 6
optical drive

location 14
precautions 43
product description 4
removal 59
spare part number 27,  30, 

59
specifications 107,  108, 

109,  110,  111
optical drive connector, spare part

number 24,  36

P
packing guidelines 45
panels, product description 3
parallel port mode 101
password clearing 47
passwords 99
pin assignments

audio-in jack 146
audio-out jack 146

external monitor port 146
headphone jack 146
microphone jack 146
modem jack 148
monitor port 146
network jack 149
RJ-11 148
RJ-45 jack 149
Universal Serial Bus (USB)

port 149
plastic parts 42
Plastics Kit

contents 28
spare part number 22,  28, 

36,  40
pointing device

components 10
illustrated 10

pointing device components
TouchPad 10
TouchPad buttons 10
TouchPad scroll zone 10

pointing devices, product
description 6

port options
1394 port 103
ExpressCard slot 103
flash media reader 103
parallel port 103
serial port 103
Smart Card slot 103
USB port 103

ports
external monitor 15
monitor 15
product description 5
Universal Serial Bus

(USB) 14,  15
power button 12
power connector 15
power cord

set requirements 150
spare part numbers 32,  34, 

35
power light 11
power requirements, product

description 6
processor

product description 1
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removal 92
spare part numbers 23,  24, 

38,  41,  92
product description

audio 5
chipset 2
diskette drive 5
Ethernet 5
external media cards 5
graphics 2
hard drives 4
keyboard 6
memory module 3
modem module 5
operating system 6
optical drives 4
panels 3
pointing devices 6
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 7
wireless 5

product name 1

R
RAID (Redundant Array of

Independent Disks)
devices 101

removal/replacement
preliminaries 42
procedures 48

restore security defaults 103
restore the factory settings 98
right-side components 14
RJ-11 jack

location 15
pin assignments 148

RJ-11 jack cable
illustrated 29

RJ-45 jack
location 15
pin assignments 149

RTC battery
removal 80
spare part number 24,  34, 

80

Rubber Kit, spare part
number 27,  37,  40

run-in test 100

S
SATA (Serial Advanced

Technology Attachment) devices
AHCI (Advanced Host Controller

Interface) 101
IDE (Integrated Drive

Electronics) 101
Screw Kit

contents 117
spare part number 32,  37, 

40
screw listing 117
Secondary Battery Fast

Charge 102
security cable slot 14
Security menu

allow reset of HP ProtectTools
security keys 99

always prompt for HP SpareKey
enrollment 99

Automatic DriveLock 99
change password 99
Disk Sanitizer 99
DriveLock 99
fingerprint reader reset 99
HP Sparekey 99
HP Sparekey enrollment 99
password policy 99
set up BIOS administrator

password 99
System IDs 99
user management 99
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